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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Qu'est-ce qu'un modèle ?

Un modèle est un gabarit que vous utilisez pour créer d'autres documents. Par exemple, vous 
pouvez créer un modèle pour des factures qui ont le logo et l'adresse de votre société en haut de 
la page. Les nouveaux classeurs créés d'après ce modèle auront le logo et l'adresse de votre 
société sur la première page.

Les modèles peuvent contenir tout ce que les documents ordinaires peuvent contenir, comme du 
texte, des dessins, des styles et des informations de paramétrage personnalisées comme les 
unités de mesure, la langue, l'imprimante par défaut et la personnalisation des barres d'outils et 
des menus.

Tous les documents dans LibreOffice sont basés sur les modèles. Vous pouvez créer, ou 
télécharger et installer, autant de modèles que vous souhaitez. Si vous ne spécifiez pas de modèle
quand vous créez un nouveau classeur, ce nouveau classeur sera basé sur le modèle par défaut 
pour les classeurs. Si vous n'avez pas spécifié un modèle par défaut, LibreOffice utilise le modèle 
vide pour classeur qui est installé avec le programme. Voir “Définir un modèle par défaut” page 21.

Que sont les styles ?

Un style est un ensemble de formatages que vous pouvez appliquer à des éléments sélectionnés 
dans un document dans le but de changer rapidement leur apparence. Quand vous appliquez un 
style, vous appliquez un ensemble de formatages en même temps.

Beaucoup de personnes formatent manuellement les cellules et les pages des classeurs sans faire
attention aux styles. Elles ont l'habitude de formater les documents selon leurs attributs physiques.
Par exemple, pour le contenu d'une cellule, vous pouvez spécifier la police, sa taille et d'autres 
formatages comme le gras et l'italique.

Les styles sont des attributs logiques. Utiliser des styles signifie que vous arrêtez de dire “taille de 
police 14pt, Times New Roman, gras, centré”, et que vous commencez à dire “Titre” parce que 
vous avez défini que le style “Titre” a ces caractéristiques. En d'autres termes, les styles signifient 
que vous focalisez votre attention non plus sur ce à quoi le texte (ou la page, ou un autre élément) 
ressemble, mais sur ce que le texte est.

Les styles aident à améliorer la cohérence dans un document et peuvent accélérer 
considérablement le formatage. Ils facilitent aussi les changements de formatage importants. Par 
exemple, vous pouvez décider de changer l'apparence de tous les sous-totaux de votre classeur, 
qu'elle soit Arial 10 pt au lieu de Times New Roman 8 pt, après que vous avez créé un classeur de 
15 pages ; vous pouvez changer tous les sous-totaux d'un document en changeant simplement les
propriétés du style sous-total.

Les styles de page aident à l'impression, vous n'avez alors plus besoin de définir les marges, les 
en-têtes et pieds de page et les autres attributs d'impression chaque fois que vous imprimez un 
classeur.

Types de styles dans Calc

Alors que d'autres composants de LibreOffice comportent plusieurs types de styles, Calc en a 
seulement deux :

• Les styles de cellule comprennent les polices, l'alignement, les bordures, l'arrière-plan, les 
formats de nombres (par exemple, monétaire, date, nombre) et la protection des cellules.

• Les styles de page comprennent les marges, les en-têtes et pieds de page, les bordures et
les arrière-plans, et la séquence d'impression des feuilles. Les attributs d'un style de page 
s'appliquent seulement quand un classeur est imprimé ; ils ne sont pas affichés à l'écran.
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Styles de cellule
Similaires aux styles de paragraphe dans LibreOffice Writer, les styles de cellule sont le type de 
style le plus basique dans Calc. Vous pouvez appliquer un style de cellule à une cellule et cette 
dernière suivra les règles de formatage de ce style. Plusieurs styles de cellule sont fournis avec 
LibreOffice ; cinq sont présentés Figure 1.

Initialement, les styles sont configurés de telle manière que si vous changez la police Par défaut, 
tous les autres styles se modifieront en conséquence. Nous discuterons sur la façon de paramétrer
ceci dans “Créer de nouveaux styles (personnalisés)” page 14.

Figure 1 : Types de styles de cellule de Calc

Styles de page
Les styles de page dans Calc sont appliqués aux feuilles. Bien qu'une feuille puisse être imprimée 
sur plusieurs pages (morceaux de papier), un seul style de page peut être appliqué à une feuille. 
Si un classeur comprend plus d'une feuille, les différentes feuilles peuvent avoir différents styles de
page qui leur sont appliqués. Par exemple, un classeur peut contenir une feuille à imprimer en 
paysage (en modifiant le style de page Par défaut) et une autre feuille à imprimer en portrait (en 
utilisant le style de page Rapport par exemple).

Deux styles de page sont fournis avec Calc : Par défaut et Rapport. Vous pouvez ajuster plusieurs 
paramètres en utilisant les styles de page. Vous pouvez également définir autant de styles de page
que vous voulez.

Parce que les classeurs sont d'abord utilisés à l'écran et non imprimés, Calc n'affiche pas le style 
de page à l'écran. Si vous voulez qu'un classeur tienne dans une certaine taille de page, vous 
devez contrôler soigneusement les largeurs de colonnes et les hauteurs de lignes, avec Fichier > 
Aperçu et Affichage > Aperçu des sauts de page pour vous guider.

Malgré cette limitation, il est intéressant de définir des styles de page pour tous les classeurs que 
vous aurez probablement à imprimer. Sinon, lorsqu'un besoin d'impression apparaît, vous pouvez 
perdre du temps à faire des essais et commettre des erreurs.
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Accéder aux styles

La principale façon d'accéder aux styles est à travers la fenêtre Styles et formatage (Figure 2). 
Vous pouvez ouvrir cette fenêtre de plusieurs manières :

• Clavier : Appuyez sur la touche F11.

• Menu : Choisissez Format > Styles et formatage.

• Barre d'outils : Cliquez sur l'icône  tout à gauche de la barre d'outils Formatage.

La fenêtre Styles et formatage peut être ancrée à gauche ou à droite de la fenêtre principale de 
Calc. Pour ancrer ou rendre flottante la fenêtre, soit gardez appuyée la touche Ctrl et double-
cliquez dans la partie grise près des icônes du sommet, soit cliquez n'importe où dans cette 
fenêtre puis faites Ctrl+Maj+F10.

Le premier bouton en haut à gauche de la fenêtre, , affiche les styles de cellule et le 

deuxième, , les styles de page.

Figure 2 : Fenêtre Styles et formatage

Appliquer les styles de cellule

Calc fournit plusieurs manières pour appliquer les styles de cellule :

• utiliser la fenêtre Styles et formatage ;

• utiliser le mode Tout remplir ;

• utiliser la liste Appliquer le style ;

• assigner des styles à des raccourcis clavier.

Utiliser la fenêtre Styles et formatage
1) Assurez-vous que la fenêtre Styles et formatage est ouverte en appuyant sur F11 ou en 

sélectionnant Format > Styles et formatage. Choisissez la liste Styles de cellule en 

cliquant sur l'icône .

2) Mettez en surbrillance la cellule ou le groupe de cellules auquel le style doit être appliqué.

3) Double-cliquez sur le nom du style de cellule.
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Utiliser le mode Tout remplir
Cette méthode est utile si vous voulez appliquer le même style à plusieurs cellules dispersées.

1) Ouvrez la fenêtre Styles et formatage et sélectionnez le style que vous voulez appliquer.

2) Cliquez sur l'icône Mode Tout remplir . Le pointeur de la souris se présente alors sous
la forme d'une verseuse.

3) Positionnez ce curseur dans la cellule à modifier et cliquez sur le bouton de la souris.

4) Pour quitter le mode Tout remplir, cliquez à nouveau sur l'icône Mode Tout remplir ou 
fermez la fenêtre Styles et formatage.

Attention Quand ce mode est actif, un clic droit n'importe où dans le document annule la 
dernière action Tout remplir. Faites attention de ne pas faire un clic droit 
malencontreusement et ainsi annuler des actions que vous vouliez conserver.

Utiliser la liste Appliquer le style
Vous pouvez ajouter une liste déroulante Appliquer le style à la barre d'outils Formatage, si ce 
n'est pas déjà fait, et sélectionner un style dans la liste pour l'appliquer aux cellules sélectionnées.

Chaque style de la liste déroulante est affiché avec un aperçu de son aspect, mais seuls quelques 
styles sont disponibles. Choisissez Plus pour aller dans la partie Styles de cellule de la fenêtre 
Styles et formatage, où tous les styles de cellule sont disponibles.

Figure 3 : Emplacement de la liste Appliquer le style

Assigner des styles à des raccourcis clavier
Vous pouvez créer des raccourcis clavier pour appliquer des styles de cellule ou de page 
couramment utilisés, y compris les styles personnalisés que vous avez créés. Voir Chapitre 14 
(Paramétrer et personnaliser Calc) pour le faire.

Appliquer les styles de page

1) Sélectionnez la ou les feuilles à modifier (cliquez sur les onglets en bas de l'écran).

2) Dans la fenêtre Styles et formatage, choisissez la liste Styles de page en cliquant sur 

l'icône . Double-cliquez sur le style de page voulu.

Pour savoir quel style de page est utilisé pour la feuille sélectionnée, regardez dans la barre d'état.
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Figure 4 : Barre d'état avec indication du style de page utilisé sous les onglets

Modifier les styles

Pour modifier un style, faites un clic droit sur son nom dans la fenêtre Styles et formatage et 
choisissez Modifier. Faites les changements dans la boîte de dialogue Style et cliquez sur OK 
pour sauvegarder ces changements.

Attention La commande Modifier est inactive dès lors qu'une ou plusieurs feuilles du 
classeur sont protégées, même si le style à modifier n'est appliqué que dans une 
feuille non protégée.

Gestion des styles
Faites un clic droit sur le nom d'un style dans la fenêtre Styles et formatage et cliquez Modifier 
pour ouvrir une boîte de dialogue Style similaire à celle de la Figure 5.

Figure 5 : Onglet Gérer de la boîte de dialogue Style de cellule
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La boîte de dialogue Style a plusieurs onglets. L'onglet Gérer, montré Figure 5 pour les styles de 
cellule, est présent dans tous les composants de LibreOffice. Il fournit les informations de base sur
le style. L'onglet Gérer pour les styles de page est identique à celui des styles de cellule.

Nom
C'est le nom du style. Vous ne pouvez pas changer le nom d'un style prédéfini, mais vous 
pouvez changer le nom d'un style personnalisé.

Lié à
Cette option est seulement disponible pour les styles de cellule : les styles de page ne peuvent
être liés. Si vous liez des styles de cellule, alors quand vous modifierez le style de base (par 
exemple, en changeant la police de Times à Helvetica), tous les styles liés seront impactés de 
la même façon. Parfois c'est exactement ce que vous voulez ; d'autres fois vous ne voulez pas 
que les changements s'appliquent à tous les styles liés. Cela mérite réflexion.

Par exemple, vous pouvez construire un nouveau style appelé rouge, dans lequel la seule 
modification que vous voulez faire est que le texte de la cellule soit en rouge. Pour vous 
assurer que les autres caractéristiques du texte soient les mêmes que le style par défaut, vous 
pouvez lier rouge à Par défaut. Ainsi, toute modification que vous ferez à Par défaut 
s'appliquera automatiquement à rouge.

Catégorie
Cette zone est en lecture seule pour les styles par défaut. Dans Calc, vous pouvez choisir 
entre Styles personnalisés et Styles masqués. Gardez Styles personnalisés, car le choix 
Styles masqués n'est pas préservé après enregistrement et fermeture du document et n'a pas 
d'influence sur l'état masqué ou non du style.

Options de style de cellule
Quand vous modifiez ou créez des styles de cellules, vous pouvez paramétrer plusieurs options, 
qui sont identiques à celles pour formater directement les cellules. Une couverture plus détaillée 
du formatage de cellule est effectuée dans le Chapitre 2 (Saisir, modifier et formater des données).
Un bref résumé suit.

Nombres
Dans l'onglet Nombres, vous pouvez contrôler l'affichage des données dans une cellule avec ce 
style. Cela comprend la spécification du type de données, le nombre de décimales et la langue.

Police
Utilisez l'onglet Police pour choisir la police du contenu de la cellule.

Effets de caractères
L'onglet Effets de caractères propose plus d'options pour la police, comme le soulignage, le barré 
et la couleur.

Alignement
Utilisez l'onglet Alignement pour déterminer l'alignement horizontal et vertical des données dans 
les cellules, et pour la rotation du texte.

Bordures
Utilisez l'onglet Bordures pour déterminer les bordures pour les cellules, ainsi que le style d'ombre.
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Arrière-plan
Utilisez l'onglet Arrière-plan pour choisir la couleur de l'arrière-plan pour une cellule.

Protection de cellule
Utilisez les options de Protection de cellule pour protéger les cellules contre certains types de 
modifications.

Options de style de page
Plusieurs options de style de page sont décrites plus en détail dans le Chapitre 6 (Imprimer, 
exporter et envoyer par e-mail), parce que le formatage d'une feuille dans la fenêtre principale de 
Calc (en utilisant Format > Page), ou lors de l'aperçu avant impression (en utilisant Formater la 
Page), modifie en fait le style de page.

Page
Utilisez l'onglet Page pour modifier l'apparence générale de la page et sa mise en page. Les 
options disponibles sont montrées Figure 6.

Figure 6 : Style de page : onglet Page

Format de papier
Vous pouvez ici déterminer le type de papier générique à utiliser. Lettre ou A4 sont les plus 
répandus, mais vous pouvez également utiliser les types de papier légal, tabloïd, des tailles 
d'enveloppes ou définis par l'utilisateur. Vous pouvez également définir l'orientation de la page 
et quel bac à papier utiliser (si votre imprimante dispose de plus d'un bac).

Marges
Vous pouvez ici fixer les marges de la page.
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Paramètres de mise en page : Mise en page
Vous pouvez spécifier ici si vous voulez appliquer le formatage aux pages de droite (impaires) 
uniquement, aux pages de gauche (paires) uniquement, ou à la fois aux pages de droite et de 
gauche qui utilisent ce style de page.

Pages en vis-à-vis formate les pages comme si vous vouliez les relier tel un livre.

La première page d'un document est par convention une page impaire.

Paramètres de mise en page : Format
Ce champ détermine le style de numérotation des pages pour ce style de page.

Paramètres de mise en page : Alignement du tableau
Cette option permet de centrer les cellules dans une page imprimée, horizontalement ou 
verticalement.

Bordures
Les onglets Bordures et Arrière-plan pour les pages sont une copie des onglets de même nom 
pour les styles de cellules et sont surchargés par le style de cellule ou les paramétrages manuels. 
Vous pouvez choisir d'ignorer complètement les onglets Bordures et Arrière-plan dans les styles de
page. Les deux onglets disposent d'une zone d'aperçu utile pour visualiser le rendu.

Comme pour formater un style de cellule, utilisez l'onglet Bordures pour choisir si la page doit avoir
des bordures, leur largeur, et à quelle distance des bordures le texte doit se trouver.

Arrière-plan
Utilisez cet onglet pour définir l'arrière-plan pour ce style de page. Vous pouvez appliquer une 
couleur ou une image en tant qu'arrière-plan.

En-tête
Utilisez cet onglet pour concevoir et appliquer un en-tête pour ce style de page. Pour des 
instructions plus détaillées sur la façon de formater un en-tête, voir Chapitre 6 (Imprimer, exporter 
et envoyer par e-mail).

Pied de page
Utilisez cet onglet pour concevoir et appliquer un pied de page pour ce style de page. Pour des 
instructions plus détaillées sur la façon de formater un pied de page, voir Chapitre 6.

Feuille
L'onglet Feuille contient les paramétrages les plus importants pour les styles de page de Calc. 
L'onglet Feuille comprend une option qui fixe le premier numéro de page, et la plupart des 
paramétrages concernent la façon dont votre classeur sera imprimé, voir Chapitre 6.
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Créer de nouveaux styles (personnalisés)

Vous pouvez vouloir ajouter de nouveaux styles. Vous avez trois manières d'y parvenir :

• créer un nouveau style en utilisant la boîte de dialogue Style ;

• créer un nouveau style depuis une sélection ;

• créer un nouveau style depuis une cellule avec la souris.

Note

Les nouveaux styles s'appliquent uniquement à ce document ; ils ne sont pas 
sauvegardés dans le modèle. Pour sauvegarder les nouveaux styles dans un 
modèle, voir “Copier et déplacer des styles“ page 15 et “Créer un modèle” page
18.

Créer un nouveau style en utilisant la boîte de dialogue Style
Pour créer un nouveau style en utilisant la boîte de dialogue Style, faites un clic droit dans la 
fenêtre Styles et formatage et choisissez Nouveau dans le menu déroulant.

Styles de cellule uniquement : si vous voulez que votre nouveau style soit lié à un style existant, 
sélectionnez tout d'abord ce style, puis faites un clic droit et choisissez Nouveau.

Les boîtes de dialogue et les choix sont les mêmes pour définir de nouveaux styles et modifier des
styles existants.

Créer un nouveau style depuis une sélection
Vous pouvez créer un nouveau style de cellule en copiant un format manuel existant.

1) Ouvrez la fenêtre Styles et formatage et affichez les styles de cellule.

2) Dans le document, sélectionnez la cellule dont vous voulez enregistrer le formatage en tant
que style.

3) Dans la fenêtre Styles et formatage, cliquez sur l'icône Nouveau style à partir de la 

sélection .

4) Dans la boîte de dialogue Créer un style, saisissez un nom pour le nouveau style. La liste 
affiche les noms des styles personnalisés existants. Cliquez sur OK pour enregistrer le 
nouveau style.

Figure 7 : Nommer un nouveau style créé depuis une sélection
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Créer un nouveau style en faisant glisser la souris
Sélectionnez une cellule (une seule) et faites-la glisser dans la fenêtre Styles et formatage. Si ce 
sont les styles de page qui sont affichés, le "déposer" ne sera pas possible. Gardez alors le clic 
gauche enfoncé et amenez le curseur sur le bouton affichant les styles de cellules, puis relâchez.

Note

Tous les caractères sont autorisés dans le nom des styles. De plus, les 
différences de casse sont acceptées : vous pouvez définir un style rouge et un 
autre style Rouge par exemple. Cependant, un tel cas de figure n'est pas 
recommandé, et certaines fonctionnalités peuvent confondre les deux styles.

Afficher et masquer des styles

Vous pouvez masquer un style non appliqué dans votre classeur, afin qu'il n'apparaisse pas dans 
l'affichage principal de la fenêtre Styles et formatage. Pour ceci, sélectionnez le style, faites un clic 
droit et choisissez Masquer dans le menu contextuel. Le style masqué n'apparaît plus si vous 
choisissez Tous les styles, Hiérarchie ou Styles personnalisés dans la liste déroulante qui se situe 
en bas de la fenêtre.

Les styles masqués apparaissent si vous sélectionnez Styles masqués dans la liste déroulante qui 
se situe en bas de la fenêtre. Pour afficher un style masqué, sélectionnez-le, faites un clic droit et 
choisissez Afficher dans le menu contextuel.

Copier et déplacer des styles

Suite à la refonte de la gestion des modèles dans la version 4.0 de LibreOffice, il n'existe plus de 
fonctionnalité de copie et de déplacement des styles telle qu'elle existait dans les versions 
précédentes.

Vous pouvez copier les styles de cellule personnalisés appliqués dans une feuille en recopiant 
celle-ci dans un nouveau classeur. Vous pouvez alors supprimer la feuille copiée dans le nouveau 
classeur : les nouveaux styles personnalisés seront conservés. Vous pouvez également copier et 
coller directement les cellules concernées dans le nouveau classeur, et ainsi ne copier que les 
styles de cellule personnalisés dont vous avez besoin. En revanche, les styles de page ne peuvent
pour l'instant être copiés d'un classeur à l'autre.

Supprimer des styles

Vous ne pouvez supprimer aucun des styles prédéfinis de Calc, même si vous ne les utilisez pas.

Vous pouvez supprimer n'importe quel style défini par un utilisateur (personnalisé) ; mais avant, 
vous devriez vous assurer que les styles ne sont pas utilisés. Si un style non désiré est utilisé, il 
serait préférable de le remplacer par un style de substitution.

Remplacer des styles (puis supprimer ceux que vous ne voulez pas) peut être très utile si vous 
gérez un classeur qui a été retravaillé par plusieurs personnes.

Pour supprimer des styles non désirés, sélectionnez-les dans la fenêtre Styles et formatage, puis 
faites un clic droit et cliquez sur Supprimer dans le menu contextuel. Choisissez Oui dans la boîte
de confirmation.
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Créer un classeur depuis un modèle

Pour créer un classeur depuis un modèle :

1) Depuis le menu principal, choisissez Fichier > Nouveau > Modèles. La boîte de dialogue 
Gestionnaire de modèles s'ouvre.

2) Cliquez sur l'onglet Classeurs. La liste des dossiers de modèles apparaît dans la zone 
centrale.

3) Double-cliquez sur le dossier qui contient le modèle que vous voulez utiliser. Une liste de 
tous les modèles que contient ce dossier apparaît dans la zone centrale (Figure 8).

Vous pouvez rechercher un modèle en utilisant le bouton Rechercher . Vous pouvez 
également trier les modèles en utilisant la commande Trier par nom du menu Action

.
Vous pouvez sélectionner un modèle (Figure 9) et connaître ses propriétés en utilisant le 
bouton Propriétés. Un aperçu du modèle est également disponible (Figure 10).

4) Double-cliquez sur le modèle, ou sélectionnez-le et cliquez sur le bouton Ouvrir. La boîte 
de dialogue Gestionnaire de modèles se ferme et un nouveau document basé sur le 
modèle sélectionné s'ouvre dans Calc.

Figure 8 : Boîte de dialogue Gestionnaire de modèles
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Figure 9 : Modèle sélectionné

Figure 10 : Propriétés et aperçu d'un modèle

Astuce

Vous pouvez également, depuis l'explorateur de fichiers du système, faire un clic 
droit sur un document LibreOffice (texte, classeur, dessin, diaporama) et choisir 
Nouveau. Un nouveau document identique au document d'origine est créé. 
Cependant, le document d'origine n'est pas défini comme modèle pour le nouveau 
document.
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Créer un modèle

Vous pouvez créer un modèle à partir d'un document :

1) Ouvrez un document nouveau ou existant du type du modèle que vous voulez obtenir 
(document texte, classeur, dessin, présentation).

2) Ajoutez le contenu et les styles que vous voulez.

3) Depuis la barre de menus, choisissez Fichier > Enregistrer comme modèle, ou appuyez 
sur Maj+F11. La boîte de dialogue Gestionnaire de modèles s'ouvre.

4) Sélectionnez le dossier dans lequel vous voulez enregistrer le modèle. Pour plus de détails
sur les dossiers de modèles, voir “Organiser les modèles” page 22.

5) Cliquez sur le bouton Enregistrer. Dans la boîte de dialogue qui s'ouvre, entrez le nom du 
nouveau modèle (Figure 11).

6) Cliquez sur OK pour enregistrer le nouveau modèle.

Figure 11 : Enregistrer un nouveau modèle

Tous les paramètres qui peuvent être ajoutés ou modifiés dans un document peuvent être 
enregistrés dans un modèle. Par exemple, voici quelques paramétrages (ce n'est pas une liste 
complète) qui peuvent être compris dans un document Calc et ensuite enregistrés dans un modèle
pour une utilisation ultérieure :

• paramétrages de l'impression : quelle imprimante, impression recto verso, taille du papier, 
etc. ;

• styles de cellules et de pages à utiliser.

Les modèles peuvent également contenir des textes et des formules prédéfinis, ce qui vous évite 
d'avoir à les retaper chaque fois que vous créez un nouveau document. Par exemple, un modèle 
de facture pourrait contenir le nom, l'adresse et le logo de votre société.

Vous pouvez également enregistrer la personnalisation des menus et des barres d'outils dans des 
modèles ; voir Chapitre 14 (Paramétrer et personnaliser Calc) pour plus d'informations.
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Modifier un modèle

Vous pouvez modifier les styles et contenus d'un modèle et ensuite, si vous le souhaitez, vous 
pouvez réappliquer les styles du modèle aux documents créés à partir de ce modèle. (Notez que 
vous ne pouvez réappliquer que les styles uniquement. Vous ne pouvez pas réappliquer le 
contenu.)

Pour modifier un modèle :

1) Depuis le menu principal, choisissez Fichier > Nouveau > Modèles. La boîte de dialogue 
Gestionnaire de modèles s'ouvre.

2) Cliquez sur l'onglet Classeurs. La liste des dossiers de modèles apparaît dans la zone 
centrale.

3) Double-cliquez sur le dossier qui contient le modèle que vous voulez utiliser. Une liste de 
tous les modèles que contient ce dossier apparaît dans la zone centrale (Figure 8).

4) Sélectionnez le modèle que vous voulez modifier.

5) Cliquez sur le bouton Éditer (Figure 12).

6) Modifiez le modèle comme vous le feriez pour un autre document. Pour enregistrer vos 
changements, choisissez Fichier > Enregistrer dans la barre de menus.

Figure 12 : Éditer un modèle

Mettre à jour un classeur depuis un modèle modifié
La fois suivante où vous ouvrirez un classeur qui a été créé avec le modèle que vous venez de 
modifier, le message suivant apparaîtra :

Figure 13 : Message de mise à jour des styles

Cliquez sur Actualiser les styles pour appliquer les styles modifiés dans le modèle au classeur. 
Cliquez sur Conserver les anciens styles si vous ne voulez pas appliquer les styles modifiés 
dans le modèle au classeur (mais voyez la note Attention ci-dessous).
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Attention 
Si vous choisissez Conserver les anciens styles dans la boîte de message de la
Figure 13, ce message ne réapparaîtra pas la prochaine fois que vous ouvrirez le 
document après avoir modifié le modèle sur lequel il est basé. Vous n'aurez pas 
d'autre chance de mettre à jour les styles depuis le modèle, à moins que vous 
n'utilisiez la macro dans la Note ci-dessous pour réactiver cette fonctionnalité.

Note

Pour réactiver la mise à jour depuis un modèle :
1) Utilisez Outils > Macros > Gérer les macros > LibreOffice Basic. 

Sélectionnez le document dans la liste, cliquez sur le symbole d'expansion (+ ou
triangle), et sélectionnez Standard. Si Standard est précédé par un symbole 
d'expansion, cliquez sur lui et sélectionnez un module.

2) Si le bouton Éditer est actif, cliquez sur lui. Si le bouton Éditer n'est pas actif, 
cliquez sur Nouveau.

3) Dans la fenêtre Basic, saisissez :
Sub FixDocV3 
' activer UpdateFromTemplate 
 oDocSettings = ThisComponent.createInstance( _ 
  "com.sun.star.document.Settings" ) 
 oDocSettings.UpdateFromTemplate = True 
End Sub 'FixDocV3 

4) Cliquez sur l'icône Exécuter le BASIC (F5), puis fermez la fenêtre Basic.
5) Enregistrez le document.

La fois suivante où vous ouvrirez ce document, la fonctionnalité de mise à jour à 
partir du modèle sera de retour.

Ajouter des modèles en utilisant le Gestionnaire des 
extensions

Le Gestionnaire des extensions fournit une manière facile d'installer des ensembles de modèles, 
de graphiques, de macros et d'autres modules externes qui ont été archivés dans des fichiers avec
une extension .OXT. Voir Chapitre 14 (Paramétrer et personnaliser Calc) pour plus d'informations 
sur le Gestionnaire des extensions.

Cette page web regroupe beaucoup d'extensions disponibles : http://extensions.libreoffice.org/.

Pour installer une extension, suivez ces étapes :

1) Téléchargez un package d'extensions et enregistrez-le où vous voulez sur votre ordinateur.

2) Dans LibreOffice, choisissez Outils > Gestionnaire des extensions dans la barre de 
menus. Dans la boîte de dialogue Gestionnaire des extensions, cliquez sur Ajouter.

3) Une fenêtre d'exploration des fichiers s'ouvre. Trouvez et sélectionnez le package de 
modèles que vous voulez installer et cliquez sur Ouvrir. Le package commence à 
s'installer. Il est possible que vous ayez à accepter un contrat de licence.

4) Quand l'installation du package est terminée, les modèles sont disponibles dans Fichier > 
Nouveau > Modèles et l'extension apparaît dans le Gestionnaire des extensions.
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Figure 14 : Extension nouvellement ajoutée

Définir un modèle par défaut

Si vous créez un document en choisissant Fichier > Nouveau > Classeur dans la barre de 
menus, LibreOffice crée un document à partir du modèle Par défaut pour les classeurs. Vous 
pouvez cependant définir un modèle personnalisé en tant que modèle par défaut. Vous pourrez 
réinitialiser le modèle par défaut plus tard si vous le souhaitez.

Définir un modèle personnalisé en tant que modèle par défaut
Vous pouvez définir tout modèle en tant que modèle par défaut, à partir du moment où il appartient
à l'un des dossiers affichés dans la boîte de dialogue Gestionnaire de modèles.

Pour définir un modèle personnalisé en tant que modèle par défaut :

1) Dans la barre de menus, choisissez Fichier > Modèles > Gérer. La boîte de dialogue 
Gestionnaire de modèles s'ouvre.

2) Dans l'onglet Classeurs, sélectionnez le dossier qui contient le modèle que vous désirez, 
puis sélectionnez le modèle.

3) Cliquez sur le bouton Définir par défaut.

La fois suivante où vous créerez un document en choisissant Fichier > Nouveau, le document 
sera créé selon ce modèle.
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Réinitialiser le modèle par défaut
Pour redéfinir le modèle de classeur par défaut de LibreOffice en tant que modèle par défaut, allez 
dans la boîte de dialogue Gestionnaire de modèles et choisissez Rétablir le modèle par défaut > 

Classeur dans le menu Action .

La fois suivante où vous créerez un classeur en choisissant Fichier > Nouveau, il sera créé selon 
le modèle de classeur par défaut de LibreOffice.

Associer un classeur à un modèle différent

Vous pouvez vouloir ultérieurement associer un classeur à un modèle différent, ou peut-être vous 
travaillez sur un classeur qui n'est pas issu d'un modèle, mais vous voulez l'associer désormais à 
un modèle.

Un des avantages majeurs de l'utilisation des modèles est la facilité de mise à jour des styles dans
plus d'un document, comme indiqué page 19. Si vous mettez à jour les styles en les copiant d'un 
modèle différent (comme indiqué page 15), le document n'a pas d'association avec le modèle 
depuis lequel les styles ont été chargés ; de fait, vous ne pouvez pas utiliser cette méthode. Ce 
dont vous avez besoin est d'associer le document à un modèle différent.

Pour de meilleurs résultats, les noms des styles devraient être les mêmes dans le document 
existant et le nouveau modèle. S'ils ne le sont pas, vous devrez utiliser Rechercher & remplacer 
pour remplacer les anciens styles par les nouveaux. Voir Chapitre 2 (Entrer, modifier et formater 
des données) pour de plus amples informations sur le remplacement des styles en utilisant 
Rechercher & remplacer.

1) Utilisez Fichier > Nouveau > Modèles. Choisissez votre modèle. Un nouveau fichier, basé
sur le modèle, s'ouvre. Si le modèle contient des textes ou des graphiques non désirés, 
supprimez-les.

2) Ouvrez le classeur que vous voulez modifier. (Une nouvelle fenêtre est ouverte.) Appuyez 
Ctrl+A pour tout sélectionner dans le classeur, puis copiez le résultat dans le presse-
papiers.

3) Basculez dans la fenêtre qui contient le classeur vide créé à l'étape 1 et collez le contenu 
dans ce classeur.

4) Répétez les étapes 2 et 3 pour chaque feuille du classeur.

5) Enregistrez le fichier sous un nouveau nom.

Organiser les modèles

LibreOffice ne peut utiliser que les modèles qui se trouvent dans les dossiers de modèles (voir 
l'astuce ci-dessous). Vous pouvez créer de nouveaux dossiers de modèles et les utiliser pour 
organiser vos modèles, et importer des modèles dans ces dossiers. Par exemple, vous pourriez 
avoir un dossier pour les modèles de factures et un autre pour les modèles de calendriers. Vous 
pouvez également exporter les modèles.

Pour commencer, choisissez Fichier > Nouveau > Modèles dans la barre de menus. La boîte de 
dialogue Gestionnaire de modèles s'ouvre.

Astuce
L'emplacement des dossiers de modèles LibreOffice varie en fonction du système 
d'exploitation de votre ordinateur. Pour savoir où sont stockés les dossiers de 
modèles, allez sous Outils > Options > LibreOffice > Chemins.
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Créer un dossier de modèles
Pour créer un dossier de modèles :

1) Dans la boîte de dialogue Gestionnaire de modèles, cliquez sur l'onglet Classeurs et 
cliquez éventuellement sur le bouton Tous les modèles pour faire apparaître la liste des 
dossiers de modèles.

2) Cliquez sur Nouveau dossier.

3) Saisissez un nom pour le nouveau dossier et cliquez sur OK. LibreOffice enregistre le 
dossier avec le nom que vous avez saisi.

Vous pouvez aussi créer un dossier de modèles et y déplacer un modèle :

1) Dans la boîte de dialogue Gestionnaire de modèles, cliquez sur l'onglet Classeurs et 
double-cliquez sur le dossier contenant le modèle que vous voulez déplacer.

2) Sélectionnez le modèle. Cliquez ensuite sur le bouton Déplacer vers le dossier et 
choisissez Nouveau dossier dans la liste déroulante qui apparaît.

3) Saisissez un nom pour le nouveau dossier et cliquez sur OK. LibreOffice enregistre le 
dossier avec le nom que vous avez saisi et y déplace le modèle sélectionné.

Supprimer un dossier de modèles
Vous ne pouvez pas supprimer les dossiers fournis avec LibreOffice ou installés en utilisant le 
Gestionnaire des extensions ; vous ne pouvez supprimer que les dossiers que vous avez créés.

Pour supprimer un dossier de modèles :

1) Dans la boîte de dialogue Gestionnaire de modèles, sélectionnez le dossier que vous 
voulez supprimer.

2) Cliquez sur le bouton Supprimer. Une boîte de message apparaît et vous demande de 
confirmer la suppression. Cliquez sur Oui. Le dossier et les modèles qu'il contient sont 
supprimés.

Déplacer un modèle
Pour déplacer un modèle d'un dossier de modèles à un autre :

1) Dans la boîte de dialogue Gestionnaire de modèles, cliquez sur l'onglet Classeurs et 
double-cliquez sur le dossier contenant le modèle que vous voulez déplacer.

2) Sélectionnez le modèle. Cliquez ensuite sur le bouton Déplacer vers le dossier et 
choisissez le dossier de destination dans la liste déroulante qui apparaît.

Supprimer un modèle
Vous ne pouvez pas supprimer les modèles fournis avec LibreOffice ou installés en utilisant le 
Gestionnaire des extensions ; vous ne pouvez supprimer que les modèles que vous avez créés ou
importés.

Pour supprimer un modèle :

1) Dans la boîte de dialogue Gestionnaire de modèles, double-cliquez sur le dossier qui 
contient le modèle que vous voulez supprimer.

2) Cliquez sur le modèle que vous voulez supprimer.

3) Cliquez sur le bouton Supprimer.
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Importer un modèle
Si un modèle que vous voulez utiliser se trouve à un endroit différent, vous devez l'importer dans 
un dossier de modèles LibreOffice pour pouvoir l'exploiter.

Pour importer un modèle dans un dossier de modèles :

1) Dans la boîte de dialogue Gestionnaire de modèles, sélectionnez le dossier dans lequel 
vous voulez importer le modèle.

2) Cliquez sur le bouton Importer. Une fenêtre standard d'exploration des fichiers s'ouvre.

3) Trouvez et sélectionnez le modèle que vous voulez importer et cliquez sur Ouvrir. La 
fenêtre d'exploration des fichiers se referme et le modèle apparaît dans le dossier 
sélectionné.

Exporter un modèle
Pour exporter un modèle d'un dossier de modèles vers un autre emplacement :

1) Dans la boîte de dialogue Gestionnaire de modèles, double-cliquez sur le dossier qui 
contient le modèle que vous voulez exporter. 

2) Cliquez sur le modèle que vous voulez exporter.

3) Cliquez sur le bouton Exporter. Une fenêtre Sélectionner un chemin s'ouvre.

4) Trouvez le dossier dans lequel vous voulez exporter le modèle et cliquez sur Sélectionner.
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